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Grafische Programmierplattform
• Rapid Application Development und 

Rapid Prototyping
• Ereignissteuerung, Objektorientierung 

und Verteilte Anwendungenund Verteilte Anwendungen
• Targets:  Real-Time, FPGA, PDA, 

Embedded, DSP, etc.
• Versionen in engl., dt. fr., jap., chin.

2 Erfassen, Analysieren und  Präsentieren
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LabVIEW Everywhere

Handheld

Embedded
(FPGA)

Sensor

Networked I/O

PC Boards

Industrial Computer (PXI)

Wireless

Tektronix Open Windows 
Oscilloscopes
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PC, Mac, Linux, Sun

Workstation

p

Kursübersicht

LabVIEW
Einführung

Data Acquisition
& Waveforms

Cluster

Schleifen und
Wiederholungen

Modulare
Programmierung

Instrument 
Control

Daten plotten 

Entscheidungs-
findung in VIs
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VI Anpassung
Arrays Strings und 

File I/O
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Lektion 1
Einführung in LabVIEW

Themen
LabVIEW Entwicklungsumgebung
Front Panel
Block Diagram
Datenflussprogrammierung

5

Datenflussprogrammierung
LabVIEW Hilfe und Dokumentation
Fehlersuche und Debugging

Virtuelle Instrumente (VIs)

Front Panel
• Controls = Eingabeelemente
• Indicators = Anzeigeelemente

Block Diagram
• Sourcecode
• Komponenten verdrahtbar

6
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Neue Elemente erzeugen
• File»New VI to open a blank VI
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• File»New… ermöglicht die Erzeugung neuer Eelemente wie Templates 
(Vorlagen), Controls, glob. Variablen, VIs, etc.

Template Browser

8
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Front Panel (FP)
Front Panel 
Toolbar

Boolean

Icon

Menüleiste
Titelleiste

Graph
Legende

Boolean
Control

Waveform
Graph

Waveform
Graph
Label
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p

Plot
Legende

Scalen
Legende

Block Diagramm (BD)
Block 
Diagram 
Toolbar Divisions

Funktion

MenüleisteTitelleiste

Wire 
Data

Graph
Terminal

SubVI
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While Loop
Structure

Numerische
Konstante

Timing 
Function

Boolean Control 
Terminal
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Front Panel und Block Diagramm Werkzeugleisten

Run button Font ring
Continuous Run button
Abort button
Pause/Continue button

• Execution Highlighting buttonWarning indicator

Alignment ring
Distribution ring
Resize ring
Reorder ring
Context Help Button

Additional Buttons on the 
Block Diagram Toolbar
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g g g
• Step Into button
• Step Over button
• Step Out button

Enter button

Broken Run button

Tools Palette

• LabVIEW kann automatisch Werkzeuge selektieren

• Manuelle Selektion mit Leertaste (2 wichtigste Elemente) oder Tab-Taste 
(4 wichtigste Elemente)

• Im FP und BD verfügbar 

12

• Im FP und BD verfügbar 

• Werkzeuge sind Instanzen von Mauszeigeroptionen

• Werkzeuge ermöglichen die Veränderung von Elementen in FP und BD

• Anzeige mit Window»Show Tools Palette oder Shift+PopUp



7

Front Panel − Controls Palette

Controls Palette

13

All Controls Palette

Block Diagram − Functions Palette

Functions Palette
Express VIs
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All Functions Palette
Alle Funktionen
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Palette Tools
Pin, um Palette zu selektieren

• Grafische “fließende” (auf Desktop frei bewegbare) Paletten 

Suche OptionenEltern-
Palette

15

• Grafische fließende  (auf Desktop frei bewegbare) Paletten 
• Subpaletten können in “floating palettes” konvertiert werden
• Mit den Optionen kann zwischen Express und  Advanced 

Palettensubset umgeschaltet werden

Suche nach Controls, VIs  und Funktionen
• Search-Knopf für 

Textsuche
• “Click and drag”-

Funktionalität um Elemente 
in BD zu bringen. Mit 
Doppelklick wird 
Elternpalette geöffnet.

16
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Anpassungen von Control & Funktions Paletten
Programme» National Instruments»LabVIEW 8.x

 i  L bVIEW V i h i  bl ib  
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• vi.lib muss im LabVIEW Verzeichnis bleiben 
• I.d.R. nur user.lib oder instr.lib erweitern um neue 

Elemente hinzuzufügen

Erzeugen des Front Panels durch Platzieren von Eingabeelementen 
(Controls) sowie Anzeigeelementen (Indicators) und dekorativen 

VI Front Panel erzeugen

Elementen (Decorations)

Numeric
Indicator Owned 

Labels

18

Numeric
Control 

Increment
Buttons

Boolean
Control 

Boolean
Indicator 
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Shortcut Menüs für Front Panel Objekte

Rechtsklick auf Elemente ermöglicht die 
Einstellung von Optionen  
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Property Page (Eigenschaftsseiten)
Rechtsklick auf Elemente 
und Auswahl “Properties” 
ermöglicht die Einstellung ermöglicht die Einstellung 
von Eigenschaften

20
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Block DiagrammFront Panel

VI Block Diagramme erzeugen

Control
Terminals

Block DiagrammFront Panel
Indicator 
Terminals

21

NodesWires

Express VIs, VIs und Funktionen
• Express VIs: Interaktive VIs mit konfigurierbaren Dialogen
• Standard VIs: modularisierte VIs, Anpassung über Terminals
• Functions: LabVIEWs fundamentale Elemente; FP und BD 

nicht vorhanden

22
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Block Diagramm – Darstellung von VIs

Icon                               Expandable Node Expanded Node 

• Function Generator VI
• Drei Darstellungen

23

Drei Darstellungen
• Links: Standard VI
• Mitte und rechts: Express VI

Block Diagramm Terminals
• Terminals sind Ein- und 

Ausgangsstellen um Informationen 
zwischen VIs sowie FP und BD 
auszutauschen 

• Terminals sind vergleichbar mit 
Parametern in textbasierten 
Programmiersprachen

• “ View As Icon” über rechte 
Maustaste ein- und ausschaltbar

24

Maustaste ein und ausschaltbar
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Block Diagramme verdrahten  Darstellung 

Scalar

Numeric

2D Array1D Array

Numeric

Boolean

String

25

Dynamic

Wiring Techniques 
Hot Spot

• Automatische Verdrahtung (aut. Wiring)
• Context Help Fenster (STRG+H) ist nützlich beim Verdrahten
• Rechtsklick auf  Draht + Clean Up Wire optimiert Verdrahtung
• Tip Strips verwenden
• Automatic wire routing
• Rechtsklick auf Terminals 

und selektieren Visible 

26

Items»Terminals

Anzeige von Terminalverbindungen in einer Funktion
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• Datenfluss analog zu 
Stromfluss (Datenquelle zu 
Datensenke)

Dataflow Programming

ate se e)

• Knoten werden abgearbeitet, 
wenn alle Eingangsterminals 
gültige Daten haben

27

• Nach der Abarbeitung stehen 
Informationen an den 
Ausgangsterminals zur 
Verfügung

Kontexthilfe
• Help»Show Context Help, <STRG-H> oder Show 
Context Help Window Knopf in Werkzeugpal.

• Hilfe Anzeigen durch Mauscursor über Objekt• Hilfe Anzeigen durch Mauscursor über Objekt
• Verbindungen:
Required – fett
Recommended – normal
Optional - angegraut

28

Simple/Detailed Context Help       Lock Help          More Help
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LabVIEW Hilfe
• Klicke auf More Help Knopf in Kontext Hilfe
• Wähle  Help»VI, Function, & How-To Help
• Klicke auf Click here for more help in Kontext Hilfe
• Detaillierte Hilfe rund um LabVIEW
• Wichtig: Verwaltung von Favoriten

29

NI Example Finder
• Help»Find Examples um 

Beispiele zu suchen
• Web-Integration
• Vielfältige Suchoptionen

30
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Debugging Techniken
Finding Errors

Klicken auf gebrochenen Pfeil listet Fehler
Execution HighlightingExecution Highlighting

Execution Highlighting ermöglicht Visualisierung des 
Datenflusses (Bläschen auf Drahten, Skalare Werte und 
Anzahl Arrayelemente auf Terminals) 

31

Debugging Techniques
Probe Rechtsklick auf Draht und Auswahl

Breakpoints
Rechtsklick auf Draht und Auswahl Set Breakpoint; Hält Rechtsklick auf Draht und Auswahl Set Breakpoint; Hält 
Abarbeitung an diesem Punkt an (Pause) und ermöglicht 
Einzelschrittbetrieb

Conditional Probe
Kombination von Breakpoint und Probe.  (mit Rechtsklick 
wählbar)

32
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Debugging Techniken (Einzelschrittbetrieb)
Step Into, Step Over, Step Out Knöpfe 

Schritt in Knoten

Schritt über Knoten

Schritt aus Knoten heraus

33

Tipps
• Tastatur-Shortcuts:

Windows      Sun        Linux       MacOS
<Ctrl-R> <♦-R> <M-R> < -R> Run a VI
<Ctrl-F> <♦-F> <M-F> < -F> Find object

• Zugriff auf Tools Palette mit <shift>-Rechtsklick
• Increment/Decrement schneller durch Drücken der <shift> - Taste

<Ctrl-H> <♦-H> <M-H> < -H> Activate Context Help window
<Ctrl-B> <♦-B> <M-B> < -B> Remove all broken wires
<Ctrl-W> <♦-W> <M-W> < -W> Close the active window
<Ctrl-E> <♦-E> <M-E> < -E> Toggle btwn Diagram/Panel Window

34

• Tools»Options: Voreinstellungen für LabVIEW Umgebung
• VI Properties (File Menü Voreinstellungen für einzelne VIs)
• Stoppen von VIs durch Tastenkombination  <STRG>+.
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Lektion 2
Modulare Programmierung

Themen
SubVIs

35

Icons und Connector Pane
SubVIs

LabVIEW Hierarchie

SubVI

36
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SubVIs

Function Pseudo Code
function average (in1, 
in2 out)

Calling Program Pseudo Code
main
{in2, out)

{
out = (in1 + in2)/2.0;
}

SubVI Block Diagram

{
average (point1, point2, 
pointavg)

}

Calling VI Block Diagram

37

Icon/Connector

terminals

•Icons repräsentieren VIs in Elternblockdiagrammen
•Daten mit diesem VI werden über Terminals ausgetauscht

Icon

Connector

38

terminals
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SubVI Beispiel – Berechnung einer Steigung
• VI innnerhalb eines übergeordneten VI nennt man subVI
• Nach dem Editieren des Front Panels und des Blockdiagramms ist die 

ICON Pane und das Icon zu editieren  Beschreibungen nicht vergessenICON Pane und das Icon zu editieren. Beschreibungen nicht vergessen

39

Icons erzeugen und verändern
• Icon: Grafische Repräsentation eines VIs
• Rechtsklick auf icon pane (Panel oder Diagramm)
• Immer alle Instanzen erzeugen
• Zwischenablage verwendbar über Shortcuts

Default Icon 
(aut. Durch LV 
durchnummeriert)

Kundenspez. Icon (besser)

40
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Konnektoren editieren

Rechtsklick auf Pane
(nur bei Front Panel)(nur bei Front Panel)

41

Verbindungen erzeugen
Klick mit
Wiring Tool

42
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Die Connector Pane
Farben werden je nach Typ zugewiesen

43

VIs als SubVIs benutzen

All Functions » Select a VI…
<ODER><ODER>

Ziehe Icon auf Zieldiagramm

44
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Klassifizierung von Terminals und Hilfe

Klassifiziere Terminals

45

Klassifiziere Terminals
• Required — Muss verdrahtet werden sonst Fehler
• Recommended — Warnung wenn nicht verdrahtet
• Optional — kein Effekt falls nicht verdrahtet

Create SubVI Option
• Schließe Bereich ein
• Verwende Create SubVI aus Edit Menü

46
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Lektion 3
Schleifen und Wiederholungen

Themen
Whil  L

47

While Loops
For Loops
Zugriff auf Daten zurückliegender Iterationen

While Loops

Repeat (code);

Until Condition met;

End;

48

LabVIEW While Loop Flow Chart Pseudo Code
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While Loops
1. Wähle While Loop 2. Schließe zu wiederholenden Code ein

3. Füge zusätzliche Elemente ein und verdrahte

49

Loop Condition 
Klicke auf Conditional Terminal mit dem  Operating tool um 
das Abschaltverhalten zu ändern 
Default: Stop if TrueDefault: Stop if True

50

Iteration Terminal Conditional Terminal
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Structure Tunnels
• Tunnels ermöglichen die Datekommunikation von und zu 

Strukturen 
• Tunnels sind Blöcke am Strukturenrand die die direkte 

Kommunikation von und zu Strukturen ermöglichen
• Abarbeitung der Elemente erst nach Anliegen von Daten
• Daten werden erst nach Abarbeitung innerhalb der Struktur 

aus der Struktur ausgegeben
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For Loops

N=100;

i=0;

Until i=N:

Repeat (code; i=i+1);

End;

52

LabVIEW For Loop Flow Chart Pseudo Code
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For Loops
• In Structures Subpalette der Funktionspalette

• Führt Struktureninhalt eine fest gelegte Anzahl von 
Iterationen ausIterationen aus

Count terminal
(Numerical input)

53

Wait Until Next 
ms Multiple
function

Wait Functions
Wait Until Next 
ms Multiple

Functions»Time 
& Dialog palette

54
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Wait Functions
Wait (ms)

Functions»Time 
& Dialog palette

Time Delay

55

Functions»Time 
& Dialog palette

Numeric Conversion
• Numerics haben standardmäßig double-precision (8 bytes) oder long 

integer (4 bytes) Repräsentationen
• LabVIEW konvertiert automatisch (falls möglich)
• For Loop count terminal konvertiert immer in Long Integer
• Gray coercion dot oder roter Punkt (ab LV 8.0) zeigt Konvertierung an

56
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Numerische Konvertierung
• LabVIEW verwendet die hochauflösendere Repräsentation
• Mit Recchtklick kann man die Repräsentation auswählen.

• Wenn LabVIEW Fließkommawerte in Ganzzahlwerte wandelt, 
rundet es auf den nächstliegenden Integerwert (z.B. rundet
LabVIEW 2.4 auf 2 und 3.6 auf 4)
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Zugriff auf zurückliegende Schleifendaten –
Shift Register (Schieberegister)
Verfügbar am linken Schleifenrand
• Rechtsklick am Schleifenran und Auswahl “Add Shift Register”g
• Rechtes Terminal speichert Daten nachg Umlauf
• Linkes Terminal übernimmt gespeicherte Daten für den nächsten Umlauf

Initial Value

Value 1

Value 1

Value 2

Value 2

Value 3

Wert 3Initial
wert

58

Vor
Abarbeit

ung
1. 

Umlauf
2. 

Umlauf
3. 

Umlauf
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Zusätzliche Shift Register Elemente

Rechtsklick Previous values are available at

Latest value
is passed to
right terminal

und
Aufziehen 
ermöglicht 
mehr
Terminals

Previous values are available at 
the left terminals

Rechtsklick
Ermöglicht 
weitere 
Schieberegister

1 loop ago

2 loops ago

3 loops ago

59

Feedback Nodes

• Andere Darstellung für Schieberegister

60
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Feedback Nodes
• Erzeugt durch Verbindung von 

Outputs zu Inputs 
<Oder><Oder>

• Platzieren über  
Functions»Structures Palette 
Analog zu Schieberegistern 
<Oder>

• Durch Konvertierung der 
S hi b i t

61

Schieberegister

Initialiierte Shift Registers & Feedback Nodes

O t t  5O t t  5

1. Umlauf VI stoppt 2. Umlauf

Output = 5Output = 5

62

Output = 5 Output = 5
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Nicht initialisierte Shift Registers & Feedback Nodes

Output = 8Output = 4 pp

1. Umlauf VI stoppt 2. Umlauf

63

Output = 4 Output = 8

Lektion 4
Arrays

Themen
Arrays - Einführung
Auto Indexing Arrays

64

Auto Indexing Arrays
Array Funktionen
Polymorphie
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• Ansammlung von Daten gleichen Typs
• Ein/mehrdimensional, max. 2          Elemente pro Dimension
• Zugriff auf Elemente über Index; erstes Element hat immer Index 0

31

Arrays

g

index
10-Element Array 1.2 3.2 8.2 8.0 4.8 5.1 6.0 1.0 2.5 1.7

0     1     2     3     4     5     6     7     8     9

2D array
0    1    2     3    4     5    6

0 
1

65

2-dim. Array mit 7 Spalten und 5 Reihen (35 Elemente) 

1 
2 
3
4

1. Wähle Array Shell (Controls 
Palette)

2. Ziehe Datentyp in Shell

Array Controls und Indicators

Erweitere ggf. 

66

Dimension
(nD Arrays)
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1. Wähle Array 
Shell (Functions 
Palette)

Zugriff auf  Array Konstanten

67

2. Ziehe Datentyp in Shell und 
initialisiere

• Mit Autoinexierung 
können Arrays erzeugt 
werden (For Loops 

Auto-Indexing
Drähte werden dicker

Auto-Indexing Enabled

auto-index 
standardmäßig)

• While Loops (While 
Loops geben 
standardmäßig letzten 
Wert ausd) Drähte bleiben gleich dick

Auto-Indexing Disabled

1D Array

0    1     2     3    4     5

68

• Rechtsklick auf Tunnel 
ermöglicht 
Veränderung der 
Indexingfunktion

Nur ein Wert wird 
ausgegeben
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Erzeugen von 2D Arrays

1D Array

0    1     2     3    4     5

2D Array

69

• Innere Schleife erzeugt Spaltenelemente
• Äußere Schleife setzt diese Elemente in Zeilen

Auto-Index Input
• Array Input kann als Ersatz für die Verwendung des Loop Terminals 

dienen
Anzahl der Terminalelemente entspricht Anzahl der Umläufe• Anzahl der Terminalelemente entspricht Anzahl der Umläufe

• Run Arrow nicht gebrochen

70
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A  Si

Gemeinsame Array Funktionen

Array Size

71

Initialize Array

Gemeinsame Array Funktionen

Array Subset

72
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Die Build Array Funktion

Element anhängen (append)

Concatenate Inputs 

Element anhängen (append)

73

Dimension erhöhen default 

Die Index Array Funktion

Element extrahieren

Reihe extrahieren

74

Ein Element der Reihe extrahieren
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Funktionseigänge können verschieden Datentypen besitzen
Alle arithmetischen Funktionen LabVIEWs sind polymorph

Kombination Ergebnis

Polymorphie

Scalar + Scalar

Array + Scalar

Scalar

ArrayArray + Array

Array

75

ArrayArray + Array

Lektion 5
Cluster

TOPICS
Clusters - Einführung

76

Clusters - Einführung
Cluster Funktionen
Error Cluster
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Cluster
• Datenstrukturen die Daten gruppieren (wie struct
in C oder record in Pascal)
El t  ü  t d  l  C t l  d  • Elements müssen entweder als Controls oder 
Indicators angelegt werden

• Ähnlich wie Drähte und Litzen in einem Kabel

77

1. Wähle Cluster shell 
aus Array & Cluster
subpalette

Cluster Controls und Indicators
2. Ziehe Objekte in Shell

78
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Creating Cluster Constants
1. Wähle Cluster 

Constant shell aus 
der Cluster
subpalettesubpalette

79

2. Ziehe Objekte in Cluster shell

Cluster Order
• Elemente besitzen Logische  (Start mit 0)
• Wähle Reorder Controls in Cluster... um Reihenfolge zu ändern

80
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Verwendung von Clustern um Daten in  SubVIs 
zu bringen

Cluster geeignet um komplexe Cluster geeignet um komplexe 
Informationen an Terminals zu 
bringen

Eliminiert 28-Terminal Limit 

Vereinfacht Verdrahtung

81

Cluster-Funktionen - Bundle

Neuen Cluster erzeugen Existierenden Cluster  modifizieren

Bu
nd

le
 e

82

Bu
nd

le
By

 N
am

e

Braucht existierenden 
Cluster
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Cluster Funktionen - Unbundle

83

Unbundle Unbundle By Name

Error Cluster
Error In und Error Out Elemente sind essentiell für das 
Fehlermanagement in VIs

(  fi d  i  C t l A  & Cl t P l tt )(zu finden in Controls»Array & Cluster Palette)

84
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Error Cluster Details

• Status Boolscher Wert “TRUE” bedeutet Fehler
• Code 32-bit Integer mit Vorzeichen der die 

Fehlernummer zurückgibt. 
– Code gleich 0 und Status= False Kein Fehler
– Code ungleich 0 und Status= False Warnung
– Code ungleich 0 und Status= True Fehler

S S i  i  A b  üb  F hl  d F hl

85

• Source String mit Angabe über Fehler und Fehlerort.

Error Handling with Clusters
• LabVIEW handelt Fehler nicht automatisch
• LabVIEW Fehlkerbehandlung funktioniert nach 

Datenflussprinzipien) Datenflussprinzipien) 
• Daisy Chain Architektur (Cluster wird durch alle SubVIs geführt; VIs 

die einen Fehler am Eingang haben werden nicht ausgeführt!) 

86

Error Cluster
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Simple Error Handler

Simple Error Handler ist geeignet für Fehlerbehandlung nach dem p g g g
Datenfluss ( in Functions»All Functions»Time and Dialog palette)

87

Verwendung von While Loops für das 
Error Handling

Error Cluster direkt mit Abbruchbedingung verdrahtbar (Schleife 
bricht bei Fehler=wahr ab – aut. Selektoin des Booleans “Error”bricht bei Fehler wahr ab aut. Selektoin des Booleans Error

88
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Lektion 6
Daten plotten

Themen
Waveform Charts

89

Waveform Charts
Waveform und XY Graphs
Intensity Graphs

Waveform Charts
Zu wählen in Controls»Graphs and Charts Palette 

90
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Charts verdrahten

Single-Plot Chart

Multiple-Plot Chart

91

Chart Properties anpassen
• Erscheinungsbild 

ändern 
• Format und 

Auflösungen der 
Achsen vändern 
Plottyp wählen

• Skalen ändern
• Dokumentation/Tip 

Strip

92

Strip
• Etc.
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Charts und Graphs anpassen
Visible Items anwählen ermöglicht Ein- und Ausblenden der Elemente:
• Plot Legend 

Di it l Di l  • Digital Display 
• Scrollbar 
• X and Y Scale 
• Graph Palette
• Scale Legend

Graph Palette

Zoom Subpalette

93

Scale Legend

• Wählbar aus Graph subpalette
• Waveform Graph – Plot eines Arrays  in Abh. von Einzelindizes
• XY Graph – Plot eines Arrays  in Abh. von eines zweiten 

Graphs

Arrays
Plot Legend
(point and line 
styles)

94

Graph PaletteScale Legend
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X0= 0.0

Single-Plot Waveform Graphs

Delta X = 1.0

X0 und 

Delta X wählbar

95

Delta X wählbar

Multiple-Plot Waveform Graphs
Jede Reihe 
erzeugt eigenen 
Plot: ot
Initial X = 0
Delta X = 1

Jede Reihe 
erzeugt eigenen 
Plot mit 

96

ot t
unterschiedliche 
Strartwerten und 
Schrittweiten
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• Zwei unabhängige Arrays 
erzeugen Datenpunkte

• Relationen möglich (mehr als ein 

XY Graphen

Relationen möglich (mehr als ein 
Wert pro X-Wert)

97

Chart und Graph Anwendung - Sonstiges
Kontexthilfe ist sehr nützlich in Zusammenhang mit Charts und Graphs

98
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Intensity Plots und Graphs

• Useful in displaying terrain, temperature patterns, spectrum analysis, and 
image processing

99

• Data type is a 2D array of numbers; each number represents a color
• Use these options to set and display color mapping scheme
• Cursor also adds a third dimension

Lektion 7
Entscheidungsfindung in VIs

Themen
Di  S l t F kti

100

Die Select Funktion
Case Strukturen
Formelknoten
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Einfache Entscheidung: Die Select Funktion
• WennTemp Scale TRUE ist, wird der obere Zweig durchgeleitet 
• WennTemp Scale FALSE ist, wird der untere Zweig durchgeleitet 

101

• Bei komplexeren Operationen mit mehr als zwei Optionen ist die 
CASE Struktur zu verwenden

Boolean Case Structure Beispiel:
Wenn Temp Scale TRUE ist, wird die TRUE Case Instanz abgearbeitet
Wenn Temp Scale FALSE ist, wird die FALSE Case Instanz 

Case Structures

abgearbeitet

102
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• In der Structuren 
subpalette der 
Funktionspalette

Case Structures

p

• Umschließe Knoten 
oder ziehe sie in 
Struktur

 Wi  K t  t lt 

103

• Wie Karten gestapelt –
eine Instanz pro Fall

Boolean und Numeric Cases

104

Verdarhte alle möglichen Ausgänge der Case Struktur
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String, Enum und Error Cases

String Case             Enum Case             Error Case

105

Note semicolonFormelknoten

• In der Strukturensubpalette wählbar
• Möglichkeit zur Erzeugung komplexer Gleichungen
• Variables wedren am Rand erzeugt

106

• Variablennamen sind casesensitiv (Groß- und Kleinschreibung beachten)
• Semicolon (;) erforderlich als Abschluss
• Context Help Fester zeigt Optionen an
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Entscheidungsfindung mit Formelknoten

107

Zwei unterschiedliche Wege, die zum Ziel führen

Lektion 8
Strings und File I/O

Themen
Wie man String Controls und –Indicators erzeugt
Dei String Funktionen an Hand von Einzelbeispielen
Wie mach man Dateiewin- und –ausgabe?
Wi  b t t  Hi h d L  L l VI

108

Wie benutzt man High- und Low Level VIs
Wie formattiert man Text um ihn dann in Tabellendateien 
verwenden zu können
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• Sequenz aus (nicht) anzeigbaren Zeichen (ASCII)
• Hinweise anzeigen, Kommunikation mit Messgeräten und Dateien, etc.
• String control/indicator befinden sich in Controls»String Subpalette

Strings

109

String Display Modi
Normal display \ code display

Password display Hex display

110
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String Length

String Functions

Concatenate Strings
(spaces here)

111

String Functions
String Subset

Match Pattern

112
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Wandeln von Numerics inStrings: Build String

113

Wandeln von Strings in Numerics: 
Scan From String

114
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Edit Format String
Scan From String Function

115

File Input und Output

Vier Hierarchieebenen:
High-level File VIs
Intermediate File VIs and Functions
Advanced File Functions subpalette
Express VIs

116

Express VIs
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• Write to Spreadsheet File

• Read from Spreadsheet File

High-level File I/O VIs

• Write Characters to File

• Read Characters from File

• Read Lines from File

117

File I/O Programmiermodell - Intermediate

Open/
Create/

Read 
and/or Close 

File
Check for

ErrorsReplace File Write to File File Errors

118
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Daten in Dateien schreiben
• Open/Create/Replace öffnet file TEST1.DAT und erzeugt refnum 

und error cluster
• Write File schreibt Daten
• Close File schließt Datei
• Simple Error Handler überprüft ob Fehler erzeugt wurden

119

Daten aus Dateien lesen
• Open/Create/Replace öffnet file in Abhängigkeit von der 

Benutzerauswahl und erzeugt refnum und error cluster
• Read File liest Daten

C ß• Close File schließt Datei
• Simple Error Handler überprüft ob Fehler erzeugt wurden

120
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Spreadsheet Strings editieren
• Spreadsheets sind populäre Tools für das Datenhandling und die 

-analyse
• Die  tab-delimited spreadheets sind die gebräuchlichsten einer 

Vi l hl  T b ll d i fVielzahl von Tabelledateienformaten
– Spalten sind durch Tabs getrennt
– Zeilen sind durch End of Line Zeichen getrennt

A spreadsheet yields:

121

Tab End of Line

Erzeugen von Spreadsheet Files

122
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Write LabVIEW Measurement File
• Besitzt open, write, close und error handling 
Funktionen

• Tab or Komma Trennzeichen verwendbar • Tab- or Komma-Trennzeichen verwendbar 
• Merge Signals function wird benutzt um Dynamische 
Datentypen zu erzeugen

123

Lektion 11
VI Anpassungen

Themen
Front Panel Erscheinungsbild ändern
SubVI Front Panels
K b d Sh t t

124

Keyboard Shortcuts
VI Properties
Paletten anpassen
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VI Properties anpassen
• Rechtsklick auf Icon Pane zum Ändern der VI Properties 
• Hat Auswirkungen auf alle Instanzen des VIs in allen 

Applikationen

125

Window Appearance
Wirkt sich nur im RUN-Mode aus

126
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Window Size
• Setzen der Minimum Panel Größe (wichtig zum 

Anpassen an Zielmonitor)
• Dynamische Größenanpassung mit Vorsicht zu y p g

genießen

127

Pop-Up Panels erzeugen
• Benutzung bei Top-Level Application Fenstern oder Dialogarten angeraten
• Kundenspezifisch anpassbar

128
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Erzeugung von Pop-Up Panels – Single 
Instance
Zugriff auf SubVI Node Setup durch Rechtsklick auf subVI Icon 

f f f d  VI Diauf aufrufendem VI-Diagramm

129

Key Navigation
Zuweisung von Shortcuts auf 
Frontpaelelemente

130
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Lektion 9
Datenerfassung und Waveforms

ThemenThemen
Plug-in DAQ Geräte
Datenerfassung in LabVIEW
Analog Input
Data Logging
A l  O t t

131

Analog Output
Counter
Digital I/O

Übersicht und Konfiguration

Aufgae der DAQ System ist die Umsetzung von 
“Real-World”-Signalen in maschinenlesbare 
WerteWerte

DAQ Systeme bestehen aus:
•Sensoren
•Signalkonditionierung
•Plug-in DAQ Geräte
•Treiber

132

Treiber
•Software
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Measurement 
Software 
Framework

NI-DAQ enthält
•Traditional NI-DAQ
•NI-DAQmx

133

DAQ Hardware Konfiguration

134

Measurement & Automation Explorer (MAX)
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Channels und Tasks

Signals
ai 0

Sine Wave 1

Si  W  2

Channel names

Signals
ai 1
ai 2

Sine Wave 2

Sine Wave 3

Tasks

135

Tasks
Timing and Triggering

The DAQ Signal Accessory

136
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Datenerfassung in LabVIEW

NI-DAQmx
Traditional NI-DAQ
Specifische VIs für
• Analog Input
• Analog Output
• Digital I/O
• Counter operations

Next Generation 
Treiber: 
• VIs um Tasks 
abzuarbeiten
• Set von VIs für alle  

Aufgaben

137

NI-DAQmx Datenerfassung

Satz an VIs die 
Analog I/O, Digital I/O und Counter 
Operationen erlauben

DAQ Assistant Express VI
• Einfache Programmerstellung
• Erzeugt lokalen Task

138

• Die meisten Appliaktionen können DAQ Assistant Express VI verwenden
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NI-DAQmx Data Acquisition Task Types

Measurement types:
•Analog Input
•Analog Output
•Counter Input
•Counter Output
•Digital I/O

139

Analog Input

Analog Input task ist Analog Input task ist 
messgerätespezifisch 

140
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Analog Input Task Timing and Triggering

Konfiguriert Abtastrate und 
Anz. An Abtastungen

Konfiguriert Start- und 
Referenztrigger

141

Data Logging
• Oft ist permanente Speicherung von Messdaten erforderlich
• LabVIEW kann Measurement Files lesen und schreiben

L bVIEW M t Fil  i d ASCII T td t i• LabVIEW Measurement File sind ASCII Textdateien

142
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Analog Output

143

Analog Output Task Timing and Triggering

Konfiguriert Abtastrate und 
Anz. An Abtastungen

Konfiguriert Start- und 
Referenztrigger

144
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Counters
Ein Counter (Zähler) ist eine digitales Timinggerät
Counteranwendungen:
• Event counting Gate Output
• Frequency measurement
• Period measurement
• Position measurement
• Pulse generation

Source

Count Register

Count register – Speichert den aktuellen Zählerstand

145

Source – Eingang der den Counter zum Weiterzählen bringt beim 
Toggeln am 
Gate – Eingang mit Enable- und Disable-Funktion
Output – Signal, das Pulse oder Muster ausgibt

Digital Input und Output
• Digital I/O können 

Leitungen und 
Ports lesen und Ports lesen und 
schreiben

• Ein digitaler Port 
besteht aus 
mehreren 
Leitungen

146
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Lektion 10
Instrument Control

ThemenThemen
Instrument Control - Übersicht 
GPIB Communication und Configuration
Instrument I/O Assistant
Virtual Instrument Software Architecture (VISA)
Instrument Drivers

147

Instrument Drivers
Serial Port Communication
Waveform Transfers

Instrument Control - Überblick
Wenn folgendes bekannt ist kann jedes Gerät angesprochen werden:
– Steckertyp − Kabeltyp
– Eelktrische Eigenschaften des Gerätes − Kommunikationsprotokolle
– Software Treiber verfügbar

Instruments Computer

148
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GPIB Kommunikation

GPIB Interface

GPIB Instruments

GPIB 
Cable

GPIB Standardisierung
1965

1975

HP designs HP-IB (Hewlett Packard Interface Bus)
HP-IB becomes IEEE 488

1987

1990

1992

1993

IEEE 488.2 adopted
IEEE 488 becomes IEEE 488.1

SCPI (Standard Commands for Programmable 
Instruments) added to IEEE 488.2

IEEE 488.2 revised

HS488 proposed

150

1999 HS488 approved
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GPIB Hardware Spezifikationen
• Max. Kabellänge zw. Geräten 

= 4 m (2 m Durchschnitt)
M  K b llä   20 • Max. Kabellänge = 20 m

• Max. Anz. An Geräten = 
15 (max. 2/3 angeschaltet)1 13

DIO5
DIO6
DIO7
DIO8
REN
GND (TW PAIR W/DAV)
GND (TW PAIR W/NRFD)
GND (TW PAIR W/NDAC)
GND (TW PAIR W/IFC)
GND (TW PAIR W/SRQ)

DIO1
DIO2
DIO3
DIO4
EOI
DAV

NRFD
NDAC

IFC
SRQ

151

12 24
GND (TW PAIR W/SRQ)
GND (TW PAIR W/ATN)
SIGNAL GROUND

SRQ
ATN

SHIELD

GPIB Software Architecture — Windows
Diagnostics Tools:

GPIB Diagnostic Tool
NI-Spy

Driver 
Software
(*.DLL)

Instrument 
Driver VIsNI-VISA

LabVIEW
Interface Board

(GPIB, PXI, 
VXI, computer 

based, etc.)

Configuration Tools:
Measurement & 

Automation Explorer
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Konfiguration von GPIB Boards und 
Instrumenten

153

Measurement & Automation Explorer (MAX)

Was versteht man unter dem  Instrument I/O Assistant?

• Zugriff mittels LabVIEW 
Express VI

• Geräte Sets Up
• Kommunikation und 

schrittweises Datenparsing 
durch 
Kommunikationsinterface

154
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Kommunikation mit einem Instrument

155

Virtual Instrument Software Architecture

VISA

• Platformunabhängig
• VISA ist das Rückgrat der 

• Interfaceunabhängig
• SCPI command set muss 

GPIB VXISerial PXI

156

• VISA ist das Rückgrat der 
IVI and Plug & Play 
Instrument Drivers

• SCPI command set muss 
bekannt sein um mit VISA 
zu interagieren
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VISA Terminology
• Resource—Instrument, Serial Port oder Parallel Port
• Session— Verbindung/Handle zur Ressource
• Instrument Descriptor—Resource location

– Format: Interface Type::Address::INSTR
– Beispiele:

157

Instrument Descriptor Syntax
• Resource Name enthät Interface Info
• VISA Aliases funktionieren auch

Interface Resource Name Grammar

Serial ASRL[board][::INSTR]

GPIB GPIB[board]::primary address[::INSTR]

VXI VXI[board]::VXI logical address[::INSTR]

158

GPIB-VXI GPIB-VXI[board][::GPIB-VXI primary 
address]::VXI logical address[::INSTR]
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VISA Resource Name

• Exakter Name und Lage des Instrumentes
• Benutzte VISA Resource Name controlBenutzte VISA Resource Name control

159

Instrument Drivers
• Mehr als 1600 LabVIEW Instrumententreiber

• Programmierung durch high-level API stark vereinfachtg g g

160



81

Installation und Zugriff auf Instrumententreiber
• Treiber herunterladbar: ni.com/idnet

• Treiberbibliotheken sind ind das  LabVIEW 
8.x\instr.lib Verzeichnis zu installieren

• Zugriff unter der Functions»Input»Instrument Drivers 
Subpalette

161

IDNET - Instrument Driver Network

• Infos über Treiber
• Hilfe zum Entwickeln von Treibern
• Möglichkeit zum Hochladen und 

Herunterladen von Treibern

162
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Instrument Driver Model

163

• Initialize • • • 

• Configure • • • • • • • •

Instrument Driver VIs

Configure        

• Action/Status • • • • • • • • • • • •

• Data • • • • • • • • • • • • • • • • • • • • • • • • • • 

• Utility • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

164

Utility                                

• Close • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 

•
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Instrument Driver Inputs und Outputs

• Instrument Descriptor
• VISA Sessions 

- Verbindung oder Link zu einem Gerät
- Erzeugt nach Initialisierung

HP34401A Initialize.vi

165

- Innerhalb einer VI Instanz zu verwenden
• Error cluster

Putting It All Together

• Konstruktor (Initialize 
instrument

166

instrument
• Methoden (Do operation(s))
• Destruktor (Close instrument)
• Check error status
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Serielle Kommunikation
• Populäre Form der Kommunikation zwischen PC und Peripheriegeräten
• Daten werden bitweise gesendet
• Niedrige Datenraten über lange DistanzenNiedrige Datenraten über lange Distanzen
• Nur ein Kabel wird benötigt, jedoch “Legacy”-Technologie, die auf den 

modernen Mainboards immer mehr verschwindet

PC Serial
Port

167

RS-232 Instrument

RS-232 Cable

Port

Serial Hardware Interfaces
• RS-232

– DCE oder DTE 
– 9-pin or 25-pin

• RS-422
– DCE oder DTE
– 8-pin

• RS-485

Pin DTE DCE

1 DCD Input Output
2 RxD I O
3 TxD O I
4 DTR O I
5 Com - -

168

– Multidrop
5 Com
6 DSR I O
7 RTS O I
8 CTS I O
9 RI I O
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Serielle Kommunikation

Terminologie
• Baud rate – bits per second
• Data bits – Invertierte Logik mit LSB am Anfang

P it  ti l  h ki  bit

169

• Parity – optionales error-checking bit
• Stop bits – 1, 1.5, or 2 invertierte bits am Datenende
• Flow control – Hardware und Software Handshaking möglich

Instrument I/O Assistant mit Seriellen Geräten

• Wähle COMX als 
Geräteadresse

• Benutze den  I/O 
Assistant wie 
unter GPIB

170
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Typisches Datenerfassungssystem

Daten-
erfassungs-

hardware

Messumwandler

Signalkonditionierung
s-

hardware

Rechner

Software

Anforderungen des Anwenders

• Jeder Anwender hat verschiedene Anforderungen:
• Anschlusstechnik
• Programmierbarkeit
• Erweiterbarkeit
• Kalibrierung
• Softwareintegration

H d i i• Hardwareintegration
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Anwendungsanforderungen

• Die Anwendung legt den Bedarf an Signal-
konditionierung fest:g
• Hohe Kanalanzahl
• Kleinsignale
• Reduzieren von Rauschen
• Besondere Anforderungen einiger Messumwandler

S h t  d  S t• Schutz des Systems
• . . .

Erforderliche Signalkonditionierung
Messumwandler/Signale Signalkonditionierung

Thermoelemente Verstärkung, Linearisierung, 
Kaltstellenkompensation

Datenerfassungs-

RTDs

Dehnungsmessstreifen

Gleichtaktspannungen oder 
hohe Spannungen

Stromerregung, 4-Draht- und 
3-Draht-Konfiguration, 

Linearisierung

Spannungserregung, 
Messbrückenkonfiguration, 

Linearisierung

Trennverstärker
Datenerfassungs-

karte
hohe Spannungen

Lasterfordernde AC-
Umschaltung oder starker 

Stromfluss

Signale mit HF-Rauschen

Elektromechanische Relais

Tiefpassfilter
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Signalkonditionierungsarten

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix

Signalkonditionierung

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix
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Auflösung

• Anzahl der Bit, die der Analog/Digital-Wandler 
benutzt  um ein analoges Signal zu repräsentierenbenutzt, um ein analoges Signal zu repräsentieren

• Legt fest, wie viele diskrete Spannungswerte 
dargestellt werden können

• Beispiel: 12-Bit- und 16-Bit-Auflösung
Anzahl der Spannungswerte = 2Auflösung = 212 = 4.096 Werte
Anzahl der Spannungswerte = 2Auflösung = 216 = 65 536 WertAnzahl der Spannungswerte = 2Auflösung = 216 = 65.536 Wert

Auflösung
• 3-Bit-Auflösung kann 8 Spannungswerte darstellen
• 16-Bit-Auflösung kann 65.536 Spannungswerte 

darstellen

5,00
3,75

6,25
7,50
8,75

10,00

Amplitude
(Volt)

Vergleich von 16-Bit- und 3-Bit-Auflösung
(5-kHz-Sinusschwingung)

16-Bit-Auflösung

3-Bit-Auflösung

011

100
101

110

111

178

100 200150500
Zeit (μs)

0
1,25
2,50

000

001

010

| ||||
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A/D-Wandlerbereich

• Auflösung verteilt sich auf den A/D-Wandlerbereich

0
-2,50

2,50
5,00
7,50

10,00

Amplitude
(Volt)

Bereich = -10 bis +10 Volt
(5-kHz-Sinusschwingung)

3-Bit-Auflösung

010
011

100
101
110

111

100 20015050
Zeit (μs)

-7,50
-10,00

-5,00
,

000
001

010

| ||||

Verstärkung
• Eingangssignal = 0 bis +5 Volt
• A/D-Wandlerbereich = 0 bis +10 Volt
• Vergleich: Verstärkung = 1 und Verstärkung = 2

5,00
3,75

6,25
7,50
8,75

10,00

Amplitude
(Volt)

Verschiedene Verstärkungen für 16-Bit-Auflösung
(5-kHz-Sinusschwingung)

Verstärkung = 2

Verstärkung = 1

100 200150500
Zeit (μs)

0
1,25
2,50

| ||||
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Verstärkung 

• Bei Kleinsignalen (z. B. bei Thermoelementen)

• Maximiert die Nutzung des A/D-Wandlerbereichs und erhöht a e t d e ut u g des / a d e be e c s u d e ö t
die Genauigkeit

• Vergrößert das Signal-Rausch-Verhältnis
Verstärker

Rauschen

Kleinsigna
l

Externer 
Verstärker Datenerfassung

s-karte

Zuleitungsdraht
ADC

+
_

Signal-Rausch-Verhältnis

• Großes Signal-Rausch-Verhältnis ist optimal
• Verstärkung möglichst nah an der Signalquelle, um 

Rauscheinflüsse zu minimieren
Signal-

spannung
Sk*-

Verstärkung
Rauschen auf
Signalleitung

DAQ**-Karten-
verstärkung

Digitalisierte
Spannung

Signal-
Rausch-

Verhältnis

Verstärkung nur
auf DAQ**-Karte

0,01 V Keine 0,001 V x100 1,1 V 10

Verstärkung in Sk*
und DAQ**-Karte

0,01 V 0,001 V x10x10 1,01 V 100

* Sk = Signalkonditionierung
** DAQ = Datenerfassung

Q

0,001 Vx100Verstärkung nur
in Sk*

0,01 V Keine 1,001 V 1000
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• Code-Breite ist der kleinste messbare Spannungsunterschied 
• Abhängig von Auflösung, Wandlerbereich und Verstärkung

Code-Breite

Bereich

• Kleinere Code-Breite = präzisere Darstellung des Signals
• Beispiel: 12-Bit-Gerät, Wandlerbereich = 0 bis +10 V, Verstärkung 

= 1

Code-Breite = Bereich
Verstärkung * 2 Auflösung

=  2,4 mV
10

1 * 212=
Bereich

20
1 * 212

=  4,8 mVVergrößerung des Bereichs: 

10
100 * 212

=  24 μVErhöhung der Verstärkung:

,
1 * 212Verstärkung * 2 Auflösung

SignalkonditionierungSignalkonditionierung

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix
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FilterungFilterung

• Entfernt ungewolltes Rauschen in bestimmten 
Frequenzbereichen q
• Hochpass-, Tiefpass-, und Bandpassfilter

• 50/60-Hz-Rauschen wird durch ein 4-Hz-Tiefpassfilter unterdrückt
• Implementiert in Software oder Hardware

• Verhindert Aliasing 
F  di  öß  l  di  h lb  Abt tf  i d  • Frequenzen, die größer als die halbe Abtastfrequenz sind, 
müssen gefiltert werden

• Filter muss in die Hardware implementiert werden

Berücksichtigungen beim Abtasten

• Abtastrate – Frequenz der A/D-
Konvertierungen

• Nyquist-TheoremAngemessene Abtastrate

Aliasing infolge einer zu niedrigen Abtastrate
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Aliasing
• Signale vor der Erfassung

• Signale nach der Erfassung ohne 
Antialiasing-Filter

Nyquist-Frequenz Abtast-Frequenz

187

Nyquist-Frequenz Abtast-Frequenz

Nyquist-Frequenz Abtast-Frequenz

• Signale nach der 
Erfassung mit 
Antialiasing-Filter

Signalkonditionierung

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix
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Linearisierung

• Konvertierung eines Eingangssignals in ein lineares 
Ausgangssignal 

• Üblicherweise durch Software realisiert

Vb

Lineare SkalierungNicht lineare Skalierung

cmaxcmincmaxcmin

Thermoelement-Linearisierung

• Das Temperatur-Spannung-Verhältnis eines 
Thermoelements ist nicht über den gesamten g
Betriebsbereich linear

• Es besteht folgender Zusammenhang:
• T = a0 + a1V + a2V2 + … + anVn

• Die ax-Koeffizienten sind unterschiedlich je nach 
Thermoelement-TypThermoelement Typ
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Signalkonditionierung

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix

Messumwandleranregung

• Passive Messumwandler erfordern das Anlegen 
einer Erregerspannung/eines Erregerstromsg p g g

• Wird von der Signalkonditionierungshardware zur 
Verfügung gestellt

• Beispiele:
• RTD (Resistance Temperature Detector)
• Thermistor

f• Dehnungsmessstreifen
• Kraftmessdose
• 360°-Drehwinkelaufnehmer (Resolver)
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PT 100 (Widerstandsthermometer)

• Widerstand ist temperaturabhängig
• 100 Ω bei 0 °C

• Benötigt Erregerstrom

an
d 

(Ω
)

400

300

200

W
id

er
st

a

100

0

-100
-300 0 300 600 900

Temperatur (°C)

2-, 3- und 4-Leitungsmessung

• Der durch den Zuleitungswiderstand erzeugte Fehler kann durch 
Verwendung einer 3-Leitungs- oder 4-Leitungsmessung verringert 
werden.

CH +
EX +

I
CH +
EX +

3-Leitungsmessung 4-Leitungsmessung

EX+
CH+

2-Leitungsmessung

EX -
CH -

IEX

RTD

C

EX -
CH -

IEX
RTD

EX
I

RTD
CH-
EX-

ϑ ϑ ϑ
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Signalkonditionierung

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix

• Der Widerstand des Dehnungsmessstreifens 
ändert sich durch Längen- oder Querschnitts-

Dehnungsmessstreifen

änderung.
Dehnung ε = Längenänderung Δl

Ausgangslänge l

ΔR
R

= k · ε

Nennwiderstand
in Ω  

Proportionalitäts-
faktor k

Maximal zulässige
Dehnung in μD

Draht-DMS 120
600

 Konst. 2,1
 NiCr 2,2

       5.000...
  50.000

k: Proportionalitätsfaktor
Folien-DMS 120

300
350
600

    ca. 2      50.000...
  80.000

Halbleiter-DMS 120
600

   100...
   160

       3.000...
       5.000...
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Wheatstonebrücke

• Messung von Widerstandsänderungen (Ausschlagbrücke)
• Messung von Festwiderständen (Abgleichbrücke)• Messung von Festwiderständen (Abgleichbrücke)
• Abgeglichener Zustand: R1/R2 = R4/R3 -> Vo = 0

Viertelbrücke

• Sensibel gegenüber Temperatureinflüssen
• Nicht linear• Nicht linear

Vo

VEX

1
=  -

1 + k ·
·

4
k · ε

2
ε
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Halbbrücke
• Temperaturkompensation

Dehnung

Aktiver DMS
Kompensations-

DMS 

• Verdoppelt die
Diagonalspannung

VEX Vo

R

R1

R ΔR

RG+ΔRFDehnung
(RG+ΔR)

Stauchung

Vo

VEX
=  -

2
k · ε

• Linear

R2 RG-ΔRg
(RG-ΔR)

Vollbrücke

• Verdoppelt die Empfindlichkeit der Halbbrücke
• Temperaturkompensation• Temperaturkompensation
• Linear

Vo = -k · εVEX
= -k  ε
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Signalkonditionierung

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix

Isolierung

• Methode zum Eliminieren von leitenden Verbindungen 
zwischen verschiedenen elektrischen Systemen
• Systeme haben keine gemeinsame Masse

• Gründe für Isolierung
• Verhindert Erdschleifen
• Bietet Schutz für Instrument und BedienerBietet Schutz für Instrument und Bediener
• Erhöht Gleichtaktspannungsbereich
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Warum Isolierung?

• Verhindert durch Erdschleifen verursachte 
Messfehler

Vs

Vm=Vs+ΔVg
Signal System

Unterschiedliche Masse-
potenziale verursachen 
Stromfluss in Erdungs-
schleifen

Vm

Δ Vg

Signalerde
Systemerde

Warum Isolierung?

• Schutz von Geräten und Benutzern

Isoliertes E/A-Gerät

~

muss für hohe Spannungen 
schutzisoliert sein
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Warum Isolierung?

Ein nicht isolierter Verstärker
besitzt einen kleinen Gleich-
t kt b i hGleichtaktspannung

• Gleichtaktspannungsbereich

~

taktspannungsbereichGleichtaktspannung

Der isolierte Verstärker hat einen
größeren Gleichtakt-
spannungsbereich

Vcm Vout

V+

V-

V+

~ Vcm Vout
V-

+

TrennverstärkerTrennverstärker

Wie wird isoliert?

Kapazitiv

Elektromagnetisch

Optisch
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Isolationsarchitektur

Kanal-zu-Kanal-
Isolation

Bankisolatio
Isolation n

• Jeder Kanal hat einen
eigenen Massebezug

• Kanäle mit gemeinsamer
Masse

• Kostengünstig

Warum Isolierung?

• Schutz von Geräten und Benutzern

Isoliertes E/A-Gerät

~

muss für hohe Spannungen 
schutzisoliert sein
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Warum Isolierung?
Ein nicht isolierter 
Verstärker besitzt einen 
kleinen Gleich-
taktspannungsbereichGleichtaktspannung

• Gleichtaktspannungsbereich

~

Gleichtaktspannung

Der isolierte Verstärker
hat einen größeren
Gleichtakt-
spannungsbereich

Vcm Vout

V+

V-

V+

~ Vcm Vout
V-

+

TrennverstärkerTrennverstärker

Wie wird isoliert?

Kapazitiv

Elektromagnetisch

Optisch



106

Isolationsarchitektur

Kanal-zu-Kanal-
Isolation

Bankisolation
Isolation

• Jeder Kanal hat einen
eigenen Massebezug

• Kanäle mit gemeinsamer
Masse

• Kostengünstig

Signalkonditionierung

• Verstärkung
• FilterungFilterung
• Linearisierung
• Messumwandleranregung
• Messbrückenvervollständigung
• Isolierung• Isolierung
• Schalter, Multiplexer und Matrix
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Relais

• Routen Signale von externen Geräten zur 
Datenerfassungskarte und umgekehrtDatenerfassungskarte und umgekehrt
• Mechanische Relais

• Langsame Schaltgeschwindigkeit
• Hohe Spannungen

• Halbleiterrelais
• Hohe Schaltgeschwindigkeit
• Kleine Spannungen (± 10V)

Schalter, Multiplexer, Matrix

+

RelaisRelais

QuelleQuelle Digitalisierer
d Q ll

U
U

_

LastLast

• Schaltet Geräte • Schaltet Geräte 

oder Quelle

• Erweitert die • Erweitert die 

Digitalisierer/QuelleDigitalisierer/Quelle

T
s

• Routet Signale• Routet Signale

Universeller Schalter Multiplexer Matrix

an und ausan und aus Anzahl an KanälenAnzahl an Kanälen
gg
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Isolationsarchitektur

Kanal-zu-Kanal-
Isolation

Bankisolation
Isolation

• Jeder Kanal hat einen
eigenen Massebezug

• Kanäle mit gemeinsamer
Masse

• Kostengünstig


